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I. Project Goals 
This Project’s goal was to teach and develop basic skills in computer-added design, “CAD,” and computer simulation using a finite element method, “FEM,” analysis. This was done using a software called NX8.5, by modeling a pair of vise-grip pliers. NX8.5 allows you to create models, assemblies and simulations. This project will first, showcases the modeling and assembly aspect of the software, as we created each of the parts of our vise pliers separately, then combining them within a single assembly. Once the CAD assembly is created, this project will demonstrate the simulation portion of the software, creating a FEM and SIM model, where we will apply loads, material properties, constraints, etc. Once the simulation is complete, results found using NX will be verified using free body diagrams. 
II. [image: ]Background and Description of Pliers
Vise-grip, also referred to as locking pliers, seen in the picture to the right, are a tool used to grasp other objects, just like any other pair of pliers, but also has the ability to adjust and lock its grip to range of widths. As you can see from the picture, vise-grip pliers are available in a range of sizes and styles and are used in a wide range of occupations. 
[image: ]  One of the main attributes of vise-grip pliers is their ability to lock its grip in place.  This is done by connecting the two handle portions of the pliers together with a piece of metal. This connecting piece is pinned to the handle connected [image: ]to the lower jaw and on the opposing handle the connecting piece is fastened such that it is free to slide. This connection creates a triangular shape with corners, seen in the figure on the left denoted with arrows, at either end of the connecting piece and the pin holding the lower jaw in place. When the grips are squeezed the triangular shape becomes thinner as the connecting piece slides into a parallel position with the handle connected to the lower jaw. However a screw, pointed out in the picture to the right, located on the bottom of the handle on which the connecting piece is free to slide, stops the connector from sliding just before it is fully parallel with the two pin-connections. When a force is applied to the handles which pushes the connecting piece into a parallel position with the two pins, it causes the connecting piece to enter a state of stress. Since the connecting piece naturally wants to return to a non-stressed state, it exerts a force pushing the connecting piece away from the parallel position. If the force exerted on the handles is great enough to push the connecting piece past parallel, the force from the stressed state pushes the middle pinned connection   until it is stopped by the opposing handle, which locks the grip of the pliers. This locking is displayed as the vise-grip pliers are latched onto a marker displayed in the picture below. Note a picture of all finished modeled and actual parts, of the vise-grip pliers can be found in the appendix.  
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III. Solid Model
In this section of the report an explanation of how to create the solid parts that make up a pair of vise-grip pliers will be given.  To do so a description along with step-by-step pictures of each piece of the pliers will be provided in the sections to follow. Included in each description you will see what is called a “Part Navigator,” which gives you an overall look at all the applications used to create each part.  


a. [image: ]Connector
[image: ]As you can see, from the Part Navigator located to the left, the first step in making the connector and most other parts is to create a sketch. This is done my clicking on the “Sketch” icon which is denoted as followed.      

[image: ]Upon interred the sketching interface of the software a plane must be selected onto which the sketch will be created. For this part the X-Y plane was selected.  Using tools located in the “Sketching Toolbar,” seen below, lines, curves, and dimensions are inserted to create the sketch.
	
[image: ][image: ]The picture below show the dimensions used to create the part of the pliers that connects the two handles used in the locking application of the tool.  
[image: ]	As you can see from the provide sketches linear as well as radial dimensions are given.
[image: ]	Once the sketch is finished, the “Finish Sketch” button must be clicked before any more work can be done this is denoted by the icon found in the Sketching Toolbar. Below is picture of the completed sketch.  
[image: ][image: ]	 	The next step is to turn the finished sketch into a solid body. This is done by using the “Extrude” feature of the software denoted by the icon as followed.    This will open up a window which allows you to input parameters such as thinness. As parameters are inputted the sketch will preview the given value, as seen below. 








[image: ]

[image: ]	Once the required dimensions are inputted you can finish the extrude command by pressing “OK.” This will complete this part of the vise-grip pliers. Below you can see the finished part as well as a photo of the actual part. 
[image: ]

b. Screw
[image: ]The screw is used to in to adjust the vise-grip pliers to various widths upon which they can lock. As you can see from the Part Navigator, to create this part we will be first creating a sketch and then use what is called the “Revolve” tool. 
[image: ][image: ]Like the pervious part a sketch is created on the X-Y plane. Photos below shows the sketch and dimensions required to make the screw. 







[image: ][image: ]Once the sketch is completed, a solid body can be made from it. On this part the “Revolve” tool is used, which is denoted by the icon.  This feature allows you to revolve a sketch around a given axis.
From there a window, seen on the right, will allow you to specify what curves to revolve and about what axis. Here we rotate the sketch about the Y-axis, 360°, to create the cylindrical shape of a screw. Again a preview will show in your work space and can be seen below. 
[image: ]
[image: ]Below is a photo of the completed Screw along with the one from which it was modeled. 

[image: ]




c. Lower Jaw
[image: ]The Lower Jaw, is used in the vise-grip pliers to grasp the lower half of whatever object that is to be griped. Also one of its pin-connections is utilized in the locking mechanism of the pliers. 
[image: ][image: ]To create this part multiple sketches will be extruded to various widths. Then a tool called “Chamfer,” denoted by the icon , is used to cut away from desired edges on a solid body, replacing it with an angled flat surface and two edges. Also used is a tool called “Unite,” denoted by the icon ,  which allows the separate extruded bodies to become one. All of this can be seen, along with the steps need to create the lower jaw, in the Part Navigator associated with this part located to the left. 
	All the sketches used to create this part will be located on the X-Y plane like the pervious parts made. However on this part each of the sketches are separate from each other so that they can be extruded to different widths. 



	Below are the required sketches needed to create the lower jaw of the vise-grip pliers. However due to the complexity of the sketch, the dimensions are omitted so that they do not clutter the photos and allow for more enhanced visual of the sketches. 
[image: ]The first sketch, displayed on the right, is where most of the sketching work was done. The entire outline the jaw is sketched using a series of reference lines denoted in the picture as gray dashed lines. One completed only the middle body of the jaw is left in the sketch while all other lines are converted to reference, as seen in the figure. Once the sketch is finished other sketches are created by just tracing the lines that were created in the first sketch. These can be seen below. 
[image: ][image: ]

[image: ]

[image: ][image: ][image: ]	Once all the sketches are completed they are each extruded to various thicknesses. This values and previews can be found below.
[image: ][image: ][image: ][image: ][image: ]
	After all the sketches have been extruded into solid bodies, the “Chamfer” tool is used to cut angles into the desired edges. Once the Chamfer tool is used a window will appear where dimensions can be inputted. Below are photos of the required values and previews of the chamfered edges. 
[image: ][image: ] 






[image: ]

Note that the chamfer displayed to the left is applied to either side of the Jaw. 



[image: ][image: ]	Once the chamfers are applied, seen to the right, the teeth along the face which is used to grasp, are cut into the solid body. To do this a sketch is created, located on the face of the jaws, normal to the outline of the teeth. This can be seen in the figure below. 

[image: ][image: ]	After the sketch is completed, it is extruded through the solid body. However, in this extrude command the Boolean dropdown “subtract” is selected, seen in the photo on the bottom left. This allows for the sketch to cut away from the target body rather than create a solid body of its own. A preview of this extrude is seen below. 





[image: ][image: ]Lastly, all the extruded bodies must be combined into one single body by using the “Unite” tool. Previews of this command are located below.

[image: ]
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Once the part has become one solid body the part is completed. Below are photos of the completed part along with the actual part it was modeled from. 
[image: ]
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[image: ][image: ]
d. Trigger
[image: ]The Trigger, is used on the vise-grip pliers to release the locking application. It is located on the inside handle, on which the connector part is pin-connected. The trigger, pin-connected as well, allows the operator of the pliers to gain the leverage to push the back past its parallel position, discussed earlier, and thus releasing it from its locked state. 
[image: ]To create this part multiple “Datum Planes” are created upon which the need sketches to complete this part will be made. Datum Planes are inserted into the working area by using the icon.
		
[image: ]

[image: ]To begin this part a reference line is sketched along the X-axis. Datum Planes are then placed along the line by   selecting the “On Curve” dropdown seen to the right. This Datum Planes can be seen in the figure below. 

	Once these planes are inserted five sketches are created, one on each Datum Plane and one located on the X-Z axis of the Datum Coordinate System, which is the origin of your workplace. The required sketches and dimensions are below. 
[image: ]
[image: ]
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[image: ]
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[image: ]	Once these five sketches are completed the top spine of the trigger is created with a new sketch on the X-Y axis. To create the spine the “Arc” tool is used to sketch an arc touching the upper most sketch and tangent to the two surrounding sketches. This arc is also dimensioned to the required length of the trigger.  This can be seen in the photo below. 

[image: ][image: ]Once this is done a Datum Plane is inserted at the end of the arc so that it is normal to the arc itself. This can be seen below. 
	
 It is on this Datum Plane the last sketch needed to create the solid body of the trigger is made. This sketch and its dimensions can be seen in the photo to the right. 

[image: ][image: ][image: ]	Once the required sketches are completed the “Swept” tool, denoted by the icon, can be used to create one solid body from all the sketches in the workplace. Within the swept command the six sketches are selected and the arc used to create the spine is selected as a guide. This can be seen in the photo below. 

[image: ]For the Swept command under “Section Options,” both the “Cubic” and “By Points” dropdowns are selected. This options will create a smooth body and as well as gives you the ability to adjust the swept command along each sketch. Below you can see the solid body created by the swept command. 







[image: ]Once a solid body is obtained, a sketch on the X-Y plane, located at the origin of the workplace is extruded so that it cuts a hole through the solid body of the trigger. Below you can see the extrude window and preview of this step. 
[image: ]

[image: ]	Lastly, the larger end is rounded off using the “Edge Blend” tool denoted by the icon. This command allows for desired edges to be rounded to a specified radius. This step is displayed is the photos below.  
[image: ]





	Below are photos of the completed trigger part as well as the actual part it was modeled from. 
[image: ]
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[image: ]
e. Handle
[image: ]The handle part in this report refers to the handle upon which the connector part is pin-connected. The handle is also pin-connected to the lower jaw part. 
The handle is made of two main parts, the actual metal handle and the rubber grip that is located around it. The first step is to create the metal piece. A sketch is placed on the X-Y plane and which is then turned into a solid body. These steps along with dimensions of the required sketch are in displayed in the photos below and continue to the next page.
[image: ]
[image: ]

[image: ][image: ]




[image: ]
[image: ][image: ]
[image: ]
[image: ]
[image: ]The next step in creating this part is to remove some of this solid body, shaping the solid the required dimensions. This is done by creating a Datum Plane along a reference line in the first sketch. From the new plane a line is sketch and mirrored along the Y-axis. The new sketch is then extruded into two planes passing through the solid body. This can be seen in the photos below.
[image: ]


[image: ]


[image: ]Then the “Trim Body” tool is used, denoted by the icon. This tool allows for a solid body to be trimmed by a plane in a specific direction. These steps are displayed in the photos below along with the solid body after it has been trimmed.
[image: ]


[image: ][image: ]

[image: ]

[image: ][image: ]From this new solid body, the “Shell” tool, denoted by the icon  is used to hallow out the inside of the handle. Tis step and required dimensions are displayed below and to the right. 
Once the solid has been shelled, holes drawn in the first sketch are extruded subtracted so create holes in the solid body. This can be seenin the photos below. 
[image: ]
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[image: ]Now that the metal potion of the handle is completed, the rubber grip can be created around it. A sketch is created on the X-Y plane and then extruded to the required width. This step along with dimensions can be seen in the photos below. 

[image: ]


[image: ]


[image: ]Again the “Trim Body” tool is used to trim away the inner potion of the rubber grips. This command uses the same planes as the trimming tools as the previous Trim Body. This step can be seen below. 
[image: ]
[image: ][image: ]As you can see from the photo on the left, the upper half of the rubber grip was trimmed as well. To fix this a sketch is made simply, by tracing over the missing area. The new sketch is then extruded to unite with the rubber grip portion on either side. This is displayed in the photos below. 





[image: ]	Once this step is completed all solid bodies created can be joined using the “Unite” tool. Lastly the “Edge Blend” tool is used to round-off desired edges of the handle. This step along with dimensions are displayed in the photos below continuing to the following page. 
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[image: ]This step completes the model of the handle part of the vise-grip pliers. Below are photos of the completed part along with photos of the actual part it was modeled from. 

[image: ]
[image: ]
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f. [image: ][image: ]Jaw Handle
[image: ]

The “jaw handle” in this project, refers to the handle of the vise-grip pliers to which the connector part is attached but free to slide. This piece holds the screw part and acts as the upper portion of the gripping jaw. However unlike the lower jaw the upper jaw is fixed to the handle, opposed to being pin-connected like the lower jaw part. 
Since both the lower and upper jaw have to same geometry, we begin this part by uploading the lower jaw part. Once the lower jaw part uploaded, the part file is renamed, creating a completely new part. From there all unwanted geometry is deleted, and the sketches are modified to the desired shape. Upon completion of the new sketches, the extrude command correlating with each sketch will stay in effect. The new sketches and solid body created can be seen in the photos below 
[image: ]
[image: ]

[image: ]	The next in this part is to create a reference line in the X-Y plane that begins at the origin of the work place. Along this reference line Datum Planes are created. These steps can be seen in the photos below. 
[image: ][image: ]Along with planes, as you can see from the photo above, that a new coordinate system was placed at the end of the reference line. This is done using the tool denoted by the symbol as follows.  

	The jaw handle part, much like the handle part, is made from two main sections, the metal inside and outer rubber grip. First we will model the upper part of the handle, there the inner metal piece is exposed. To do so sketches are created on the three newly created planes. This step is displayed below along with required dimensions. 
[image: ][image: ]
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[image: ]Once these sketches are finished two swept commands are used to create solid bodies. Guides for these swept commands are sketched on the X-Y plane. This step can be found in the photos below. 
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[image: ]






[image: ][image: ]Once these solid bodies are created, four new Datum Planes are placed along the reference line. These planes are used to create sketches needed to create the lower portion of the handle which is covered with the rubber grip. This step along with dimensions needed to create these sketches are displayed in the photos to follow. 
[image: ]
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Once these sketches are finished again two swept commands are used. One swept will pass through all four of the new sketches while the other will only pass through three. The guides for both of these swept commands are drawn on the X-Y axis. Below photos display these steps. 
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Below you can see a photo of the jaw handle part up to this step. 
[image: ]



[image: ]
	The next step is to trim away some of the rubber grip. This is done my extruding a sketch through the body of the grip and using the “Trim Body” tool. This step can be seen in the photos below. 




[image: ]





[image: ]The next steps to creating this part are to first “Unite” the two outer swept bodies, then “Subtract” the inner swept bodies from inside it. Below are photos that display these steps. 
[image: ]





[image: ]The next step is to trim away part of the upper exposed metal part of the handle. This is done by creating a sketch, extruding the sketch, then trimming the target body about the new extruded plane. These steps are displayed in the photos below. 



[image: ][image: ]

	After the trim body command is completed an edge blend command is used to round off the edge of the exposed metal. This is displayed in the photo to the right. 


[image: ]Next a hole is made though the upper exposed metal portion of the handle by sketching and extruding a hole located at the origin of the work place. This step can be seen below. 
[image: ]





Once this step is complete, the lower part of the handle, in which the screw is inserted, is to be created. This is done by simply extruding the sketch already located at the lower most section of the handle. This can be seen along with the required dimensions in the photo below. 

[image: ]	
[image: ][image: ]Next a hole is created on the bottom face of the newly extruded solid. This is done by using the “Hole” tool, denoted by the icon. This step along with the required parameters are located in the photo below. 

[image: ]Once a hole is created through the handle, an edge blend command is used to round off the bottom edges. This step along with required dimensions are displayed in the photos below. 
Once this step is completed all solid bodies are united into one and the model of the jaw handle part is completed. Below are photos of the completed model along with photos of the actual part it was modeled from. 
[image: ][image: ]

[image: ]
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IV. Solid Model Assembly
[image: ]The assembly portion of this project will explain how to assemble the parts created above into one single working tool. To do this a new assembly part must be created. From there the needed parts are imported using the “Add Component” window seen below. 
[image: ]





	Above is a photo of the “Assembly Navigator,” very much similar to the Part Navigator. Displaying used commands and parts within the assembly. 
	In the assembly each part is inserted and constraints are applied between all the parts, so that the model operates in the same way as the actual pliers. Each part and their constraints needed to complete the assembly are displayed in the following pages. 

[image: ]The “Fit” command seen below is used to align two cylindrical faces about the same axis. 

[image: ]“Touch Align” is a command used to touch two surfaces together.
[image: ]

[image: ]The “Distance” command seen below constrains to objects to be a specified distance from each other. 


[image: ][image: ]
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[image: ]
[image: ]
[image: ]	Once all the above constraints and parts are added to the assembly it is completed. Below are photos of the finished assembly model, as well as, the actual pair of vise-grip pliers from which it was made. 



[image: ][image: ]
[image: ]



V. FEM and SIM 
Within this section of the report, NX will be used to create a FEM and SIM model, of the pair of vice grip pliers. These models allow the user to test, designed CAD parts and assemblies, with various, loads, constraints, etc. The following sections will explain in detail how to use NX to create the FEM and SIM models. Screen shots, description of the tools used within the software, and why they were used will also be described. 
It should be noted for the simplicity of the professor, a single CAD model assembly of the pliers was distributed. It is this CAD model that will be used for the remainder of this project.  
a. Getting Started 
[image: ]First, in NX the new CAD model assembly is opened, this file along with all CAD models is saved with the file ending “.prt.”  Once opened the CAD assembly with all of its parts and assembly constraints will appear in the work space and can be seen in the photo on the right.
The next step is to create a FEM and SIM file for the CAD assembly. This is done by right clicking “Start” and selection “Advanced Simulation” from the drop down. Once this step is complete the Simulation Navigator will appear on the left side of the screen. 

[image: ]This Simulation Navigator is much like the Part Navigator, in that it complies work done within the software and groups with in collectors. To the left, can see the CAD assembly “.prt” file in the Simulation Navigator. Right click the file, and select “New FEM and Simulation.” 
This will create both a FEM and SIM model of the vice grip pliers. These FEM and SIM files will be saved with the file endings “.fem” and “.sim” respectively.  NX users can switch between multiple files using the “windows” dropdown located at the top of the screen.  
b. Creating a Mid-surface
The next Step will be to create thin 2-D surface’s, which will replace the 3-D solid models of both handles and the connector piece. This is done within the “Idealized” file, which was created by NX at the same time as the “.fem” file. The idealized file has a file ending of “_i.prt,” and can be found in opened using the “window” dropdown. 
[image: ][image: ]Once in the idealized file, these three parts will be “Promoted” so that a “Mid-Surface” can be created for each of them. The “Promote Body” tool, denoted by the icon,  , allows users to modify and create CAD parts from existing FEM. Once the Promote Body tool has been opened, both handles and the connecting piece is selected. This step can be seen in the photo on the right. 

[image: ]Next, seen to the left, from the “Advanced Simulation” drop dropdown “Midsurface by Face Pairs” is selected. 

[image: ]	
Once the dialog box, the strategy dropdown is changes to “Progressive.” Once a body is selected, click “Automatically Create Face Pairs.” This step is shown in the photo to the right and is repeated for both handles and connector.
This will create a thin 2-D mid-surface sheet, within each of the parts. These sheets can be found in your Simulation Navigator, and can be renamed for later reference. Seen below is the Simulation Navigator along with a photo of the mid-surfaces of the three parts.

[image: ]
[image: ]



c. 2-D Body Mesh 
The Next step will be to create a “2-D Mesh,” with in the FEM file, on the newly created mid-surfaces of both handles and connector. First, open the “.fem” file using the “window” dropdown. Note that all work done in the Idealized file ill transfer over to the FEM file. The Simulation Navigator, with all the tools used in this step, checked in red, can be found below. 
[image: ]	Seen in the Simulation Navigator on the left, Handle_B and the Connector, are made from a single “2-D Mesh.” While Handle_A, is made from “2-D Mesh” and a “2-D Extrude Mesh.”
[image: ]	The First step will be to smooth out the surface of Handle_B. This is done by selecting the “Merge Face” tool denoted by the icon. Selecting Handle_B and clicking OK, NX will smooth out the surfaces so that the faces of the handle are continuous. This can be seen in the photo below.  
[image: ]






[image: ][image: ]Once this is done, the “2-D Mesh” tool, denoted by the icon, , is used to create a mesh on top of the mid-surfaces of the Connector, Handle_B and the main body of Handle_A. 
[image: ]	Once in the 2-D mesh window, under “Element Properties” in the “Type” dropdown, “CQUAD4” is selected. This will create a 2-D mesh on top of the mid-surfaces. This step is shown in the photos to the left. 

[image: ]



[image: ][image: ]Lastly, selecting “Insert”> “Element”>”Extrude” and selecting “2-D Mesh” the bottom part of portion of Handle_A is created. This step can be seen below.





[image: ][image: ]Note that once the bottom portion of Handle_A is extruded it is important to check if the extrude command was done properly. That is that the extruded portion of the handle is part of the same mesh as the rest of Handle_A. To do this a tool in NX is used called “Element Edges” and is denoted by the icon. This tool allows users to display/highlight the edges of a desired 2-D Mesh. Shown in the photo below, first select both the extruded part and the main body of Handle_A. Then click “Generate Element Outlines,” and in the workspace the edge of the selected body’s is displayed in purple. Seen in the photo below, since there is no purple line separating the extruded mesh from the rest of the Handle_A, they are indeed one single mesh. 
[image: ]Once this is step is done, the 2-D meshes needed to create the plier are complete. This meshes can be found and renamed in the Simulation Navigator under “2-D Collectors.” To the right is a photo of the completed 2-D meshes of both handles and connector. 
 


d. 3-D Body Mesh
[image: ]Next, 3-D Meshes will be created in place of both the lower and upper jaws of the vice grip pliers. Seen on the left is a photo of the portion of the Simulation Navigator which represents this step.  
[image: ]The 3-D meshes are created using a tool in NX called “3-D Tetrahedral Mesh,” which is denoted by the icon. Note that for most 3-D modeling using a “3-D Tetrahedral Mesh” is not preferred because it will add stiffness to the solid. However since the jaws in this assembly are relatively stiff in comparison to the rest of the parts, the added stiffness due to the “3-D Tetrahedral Mesh” is arbitrary and is ok to use in out model.  

[image: ][image: ] Once in the 3-D tetrahedral mesh window CTETRA(4) is selected from the type dropdown. Once the body of the jaw is selected, click OK. This should be done for both jaws. This step is seen in the photos below. 

	Once this step is complete all 2-D and 3-D meshes needed to create the handle are complete. Below is a photo the completed 2-D and 3-D meshes that make up the vice grip pliers. 
[image: ]







e. Hinges
[image: ]This step, will demonstrate how to create the 3 hinges needed for the vice grip pliers to operate correctly. These hinges will create pin-connections from Handle_B to both the connector and the lower Jaw, as well as, the lower jaw to Handle_A. To the right, is a photo of the Simulation Navigator with all related parts to this step checked. 
[image: ][image: ][image: ]To create a hinge nodes are inserted on the top and bottom holes of the handles. From there the “1-D Connector” tool is used, denoted by the icon, , to connect the newly created middle nodes to the surrounding nodes along the edge of the holes.  In the 1D Connection window select “Node to Node” and “RBE2” from the dropdowns. Selecting the middle nodes as the source, the target node on the edge of the hole can be selected by setting the filter to “Related Nodes” and “Polygon Edge” This step can be seen in the photos below.  

	The Next step in creating a hinge is to insert a new node in the middle of the hole of the body which is surrounded the to “RBE2” connections made in the previous step. From this newly created node another “RBE2” 1D connection is made to its surrounding nodes. In the case of the hinge involving the Connector and Handle_B the surrounding target nodes involved in the “RBE2” will consist of the nodes on a single edge. On the other two hinges the targets will consist of the nodes which lie on the face of the inner cylindrical hole of the lower jaw. Nodes on the face of a solid can be selected using the filter option “Feature Angled Nodes.” This step can be seen in the photos below. 
[image: ]



[image: ][image: ]	Next, a new node is created on top of the middle “RBE2” connection. Then displaying just this new node, by hiding the “RBE2” connection made in the previous step, a bar is insert using a tool called “1-D mesh,” denoted by the icon.  Selecting the dropdown “CBAR” a bar is created between the other most “RBE2” and contains the newly created node. This step can be seen in the photo below. 




	 The last step, in making a hinge, is to connect the coinciding nodes from the middle “RBE2” connection to the node within the “CBAR.” This is done using a 1D connection tool called “CBUSH” which created a bushing between two nodes so that the user can control their interaction with each other. To create this bushing click “Insert” > “Element” > “Create” then select “1D Connection” and “CBUSH” from the dropdowns. This step is shown in the photo below, the text “SP” represents a “CBUSH” between two nodes. 
[image: ]




	This process is the same for all three hinges, below are photos of the hinge between the Lower Jaw and Handle_A. 
[image: ][image: ]
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[image: ][image: ][image: ]	Note that once all hinges are completed, it is possible to check if they are created properly by using a tool in NX called “Show Adjacent” denoted by the icon. This tool allows the user show which features which are attached to one another by related nodes. To perform this check, display only one of the two outer 1-D “RBE2” connections associated with the hinge, open “Show Adjacent” and select the “RBE2.” This can be seen in the photo on the right.  
Seen in the photo on the left, both the “2-D Mesh” of a handle and the upper half of the “CBAR” associated with the hinge are attached to the “RBE2” connection. 
[image: ][image: ]	Next, the upper half of the “CBAR” is selected. This can be seen in the photo to the right. 
Seen in the photo to the left, both the “CBUSH” and lower half of the “CBAR” are attached. 
[image: ]	Next, the 1-D “CBUSH” connection attached to the middle of the “CBAR” is selected. 

[image: ][image: ]Seen to the left attached to the “CUSH” is the middle “RBE2” attached to the Jaw or Connector depending on the hinge. 
Next the lower half of the “CBAR” is selected. This can be seen in the photo to the right. 
[image: ][image: ]As seen to the left, attached to the lower half of the “CBAR” is the other “RBE2” mesh associated with one of the Handles.  
Next, the lower “RBE2” connection is selected. This is shown in the photo on the right. 
[image: ]Attached to the last “RBE2” is the 2-D mesh of the handle, just like the upper “RBE2.” This can be seen in the photo o the right. 
[image: ]Last, selecting the middle “RBE2,” shown on the right, attached is the 2-D or 3-D Mesh associated with either the Jaw or Connector. 
Once this is done all hinges needed for the vice grip pliers are completed. Note that all “RBE2,” “CBAR,” and “CBUSH” can be organized collectors are renamed in the Simulation Navigator. That is 1D connections with the same properties can be combined into a single collector. Below is a photo of the vice grip pliers up to this point with the newly created hinges in place. 
[image: ]













f. Screw/Connector/Handle_A
[image: ]In this step we will create the Screw, which is located on the bottom of Handle_A. Once the Screw is created it will be connected to both Handle_A and the Connector. 
On the right is a photo of the Simulation Navigator with all related parts to this step checked. 
To begin, 2 nodes are placed in the center of both faces at either end of the Screw CAD geometry and a third in the middle of the cylindrical body formed from the 2-D mesh extrude on the bottom of Handle_A. Next, a 1D “CBAR” mesh is created containing all 3 newly created nodes. This step is seen in the photos below.   
[image: ][image: ][image: ]Next, a 1D “RBE2” connection is created. Selecting the middle node in the Screw as the “source” and the nodes on the inner cylindrical face of the extruded mesh portion of Handle_A, excluding the nodes on the bottom edge, as the “target.” This is seen in the photo below. 


[image: ]	Now that the Screw in connected to the inside of the lower portion of Handle_A. A second “RBE2” connection is made at the bottom edge of Handle_A. 
Inserting a new “source” node in the center of the bottom circular edge of Handle_A, the connection is made to the “target” nodes on the edge on Handle_A. This connection will be used later to apply loads to the vice grip pliers. This step can be seen in the photo to the right
[image: ]Now, a connection between the top of the Screw and the Connector is made. A new node is inserted on top of the top node of the Screw. By hiding the Screw the newly created node is made visible. Next another 1D “RBE2” connection is created selection the new node at the “source” and the nodes along the bottom edge of the Connector’s 2-D Mesh. This step is demonstrated by the photo to the left. 
[image: ]	
Lastly, a 1D “CBUSH” connection is created between the two coinciding nodes located on the top of the Screw. This step, is seen completed in the photo on the right.

[image: ][image: ]Much like the check done to the hinges, “Show Adjacent” can be used to check the creation of the Screw/Handle/Connector connection.  

[image: ][image: ]While displaying only the “CBAR” associated with the screw in the work space, it is selected used “Show Adjacent.” This step, shown in the photos above, will reveal that the Screw is directly attached to the “RBE2” connection to Handle_A. As well as, to the “CBUSH,” indicated by text “SP” near the top of the Screw. 

Next, seen in the photos above, select the “RBE2” connection. Using “Show Adjacent,” it can be seen that the “2-D Mesh” of Handle_A is directly attached to the “RBE2.” 


[image: ][image: ]	Again, using the “Show Adjacent” tool, select the “CBUSH” located at the top of the Screw. As shown in the photos below, attached to the “CBUSH” is a “RBE2”connection. 

[image: ][image: ]Show in the photos below this process is repeated, selecting the “RBE2” at the top of the Screw this time. As you can see the “2-D Mesh” of the Connector is attached to the “RBE2” at the top of the Screw.
	
Once this is done, the check is complete. 


g. Polyurethane
[image: ]In this section of the report, a piece of polyurethane will be created between two Jaws.
To the left is a photo of the Simulation Navigator with related parts to this step checked.  
[image: ]First, two new nodes, are created on top of the existing middle two nodes on the upper most edge of both Jaws. Creating a total of four new nodes. Displaying these newly created nodes by hiding the two 3-D Jaw meshes, two additional nodes are created, between these two pairs of nodes, using the tool called “Node Between Nodes.”  Next a “2-D Mesh” is created containing these 6 new nodes. This step can be seen in the photo the right.
[image: ][image: ]Note that while creating the “2-D Mesh” in the previous step, nodes will need to be selected in a counter-clockwise order. This will insure that the polyurethane is positioned with its normal facing up. This can be check using a tool Called “2-D Element Normals” denoted by the icon. Selecting the newly created “2-D Mesh” and clicking “Display Element Normals,” this tool will display the normal of any 2-D element. This step is demonstrated in the photo to the right.  
[image: ]	Last, four, 1D “CBUSH” connections are created, between the coinciding pairs of nodes along the edge of the two jaws. This step is now finished and displayed in the photo below. 






h.  FEM Clean Up
[image: ]At this point, all of the FEM is created for the vise grip pliers, and the “.fem” file is near completion. However before a simulation can be performed, first, a new coordinate system is to be created, which is later used to apply loads. Next, material properties and dimensions must be assigned to each “CBAR,” “2-D Mesh,” and “3-D Mesh.” Lastly, each “CBUSH” must be given a Stiffness and coordinate system. 
Two the right is a photo of the Simulation Navigator in full. Meshes were organized into collectors were renamed for organizational purposes. 

[image: ][image: ]	To create a new coordinate system click “Incert” > “Model Preperation” > “Coordinate System.” From the dropdown “Z-axis, X-axis, Origin” is selected. The Origin is selected as the center node of the 1D “RBE2” connection located at the bottom edge of Handle_A. For the Z-axis, select the same z-axis at the datum coordinate system. To designate an X-axis, click on the middle “vector point” button and select “Two Points” from the drop down. From there the same origin node is selected as well as a node on the middle of the bottom most edge of Handle_B. Next by clicking on “Point Dialog” button, set the Z-point of the node located on Handle_B to zero. Click OK to finish completing the new coordinate system. This step is demonstrated in the photos below. 

[image: ]	Next, all 1D “CBUSH” collectors must be given a stiffness. To do this right click on the “CBUSH” collector and select edit, this can be seen to the right. 

	Selecting the “Create Physical” button, each “CBUSH” can be defined, killing the needed degrees of freedom (DOF) for each collector. Within this project three 1D “CBUSH” collectors exist “Cbush Handle_B” which includes the two hinges made on Handle_B, “Cbush Jaw” which is the last of the hinges, and lastly “Cbush Ball-In-Socket” which includes the 4 connections between the jaws and the polyurethane as well as the connection between the Screw and the Connector. 
[image: ]	For the 1D “CBUSH” collector “Cbush Handle_B” all the DOF are killed except the rotation about the Z-axis. This is done by entering a large stiffness for all DOF but the “Z Rotation per Radian” in the “Physical Property Table.” This can be seen in the photo to the left.  
	Since the 1D “CBUSH” collector “Cbush Jaw” is composed of a hinge as well we can simply assign it the same stiffness as the previous collector. By selecting it from the dropdown. This is displayed in the photo below. 
[image: ]





[image: ]	 The last 1D “CBUSH” collector, “Cbush Ball-In-Socket” the “Physical Property Table” should be created, so that the only translation along the X,Y, and Z axis’s are killed. This will allow for these connections to carry no moment, making both the Connector and Polyurethane a two force members. This step is shown in the photo to the right.
	
Next, all “CBUSH” meshes within the collectors must be assigned a coordinate system. This is done by right clicking on the meshes and selecting “Edit Mesh Associated Data” and changing the “CSYS Type” dropdown to “Absolute.” This step is demonstrated in the photos below.   
[image: ][image: ]

[image: ]
Next material and dimensions must be assigned to all 1D mesh “CBAR” collectors. To do so right click the collector and select edit. This is seen in the photo to the left. 

[image: ]
From here assign the material to Steal, which is demonstrated in the photo to the right. This should be done for all “CBAR” collectors. 

[image: ]
Along with material properties each “CBAR” collector must be given dimensions. Clicking the “Fore Section” button in the photo above, will open the window located in the photo to the right. As displayed in the photo “ROD” is selected from the drop down and the proper dimensions are inputted.  




[image: ]	The last step in completing the “.fem” file, before simulations can be ran, will be to assign material properties to all “2-D Mesh” and “3-D Mesh” Collectors. This is done by right clicking on the collectors and selecting edit. From there materials can applied to each collector. All of which should be steel except for the “2-D Mesh” between the two jaws which should be set to polyurethane. This step is demonstrated by the following pictures.   
[image: ]




[image: ]
[image: ]
i. Gluing
[image: ]Now that the FEM portion of the project is completed, it is time to move to the SIM portion. Using the “window” dropdown select and open the “.sim” file. This section will show how to secure the Upper Jaw to Handle_A using a tool called “Surface to Surface Gluing” located in the “Simulation Object Type” dropdown. This can been seen in the photo to the right.
[image: ]Within the “Face Gluing” window the “Search Distance” must be adjusted. Next, select the “Source Region” to all nodes on the “TOP” surface of the Upper Jaw. This step is displayed in the photo to the right.

[image: ]
Last select the “Source Region” to all nodes on the bottom surface of the section of Handle_A that overlaps the Upper Jaw. Seen in the photo to the left.  

[image: ]This will complete the gluing process, the final gluing product with appropriate values are displayed in the photo below.  

j. Forces and Constraints 
In this section forces and constraints are applied to the vice grip pliers.  To do so it is necessary to covert the coordinate system made previously to the working coordinate system (WCS). To do so, simply right click on the coordinate system found in the Simulation Navigator and select “SET WCS.” This step is displayed in the photo below. 
[image: ]




Next, Forces are applied by selecting [image: ]“Forces” from the “Load Type” drop down. This can be seen in the photo to the right. From there two equal forces are created. One in the center of the 1D “RBE2” connection, located at the bottom of Handle_A, and in the positive X-axis direction. The second is located on the middle node on the bottom most edge of Handle_B, and is in the negative X-axis direction. Creating these two forces is demonstrated by in the following photos.   
[image: ]






[image: ]








The Last step in creating this model will be to constrain the two nodes located in the middle of the “2-D Mesh” of polyurethane. To do so select “Fixed Constraint” from the “Constrain Type” dropdown. One this is done select the two nodes and press OK. This step is displayed in the photos below.
[image: ]


[image: ]






VI. RESULTS
Within this section of the report, results from NX will be compared to the result of a static analysis of the vice grip pliers. However before the simulation is ran in NX it is necessary to tell NX what you want to solve for then running the simulation. To do this right click “Solution” in the “.sim” file’s Simulation Navigator select solve. Then select “Edit Solution Attributes” to modify what NX will solve for while running the simulation. In the “Case Control” tab select the edit symbol next to “Output Requests.” Then, in the “SPC Forces” tab set the “Output Medium” to “PRINT.” Next, in the “Forces” tab again set the “Output Medium” to “PRINT.” Also, it the “Forces” tab select the create group button, and create a group consisting of all “CBUSH” connections. Select the newly created group and click OK and run the simulation.   
Once all this is completed, the results and be displayed visually in you work space by double clicking the “Results” tab in the Simulation Navigator. These said results are also saved to a file created by NX which is referred to as the “.F06 File.” This file contains numeric results displayed via text. It is also where the forces within each of the “CBUSH” connections will be displayed. On the following page are photos of the results displayed by NX. 
[image: ][image: ]


	When solving for the forces in the “CBUSH” connections a 2-D static analysis is used. Below are the Free Body Diagrams with the static analyses needed to solve for these forces. 
[image: ]
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Comparing results with the static analysis and the results generated by NX in the “.F06 File” we can conclude that our results are correct. On the following page you can see a photo of the results found in the “.F06 file” and indeed they are correct. 

[image: ]

	Seen in the “.F06 File” 5 of the “CBUSH” don’t carry any moment. These are the “CBUSH” connections created as a “Ball-In-Socket” and act as a two force member. From those 5, 4 of them are the same magnitude but different directions. These 4 are the “CBUSH” connections between the jaw and polyurethane. The last of the 5 with no moments is the “CBUSH” connection located at the top of the screw. The 3 that carry moment in the X and Y correlate to the 3 hinges. 
	Also seen in the “.F06 File” are the 2 SPC Forces. These numbers are very small, this is because the FE model was constraint at the top and forces were applied along the same axis but in opposite directions. This cancels out any reaction forces. 


VII. Summary
In summary, this project was able to teach us basic CAD or computer-added design. This was done by using a software called NX8.5 as we modeled each part of a pair of vise-grip pliers. These models were created using a series of tools and commands found within the software, that allow for solid bodies to be created from sketches. Once all the solid bodies were created an assembly was made. This assembly combined and constrained all the individual parts of the vise-grip pliers. These constraints allow the assembly model to operate like the pair of pliers it was modeled from. Once the assembly was completed a “.fem” and “.sim” file were created. In them a FE model of the vice grip pliers was able to run a simulation with loads and constraints. Once the simulation was complete a static analysis was done to check the solution of  the NX simulation. 
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VIII. Appendix
a. [image: ][image: ]Connector
[image: ]
b. Screw
[image: ]


c. Lower Jaw 
[image: ][image: ]






d. [image: ][image: ]Trigger

e. Handel
[image: ][image: ]


f. [image: ]Jaw Handel 
[image: ]
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